# Table of Contents

## 1 EPLAN Engineering Center One ................................................................. 6
  1.1 Typical ......................................................................................... 7
  1.2 Macros and Placeholder Objects ...................................................... 7

## 2 General Requirements .............................................................................. 8
  2.1 Recommended Workstation Configuration ........................................... 8
  2.2 Network ......................................................................................... 8
  2.3 Operating Systems ........................................................................... 8
  2.4 EPLAN Products .............................................................................. 8
  2.5 Microsoft Products .......................................................................... 9

## 3 Files and Folders ....................................................................................... 10

## 4 Structure of the EEC One-Excel-Editor .................................................. 11
  4.1 Table Sheet Settings ......................................................................... 11
     4.1.1 EEC One Settings ................................................................. 11
     4.1.2 EPLAN Electric P8 Settings .................................................... 11
     4.1.3 Typical Settings ....................................................................... 12
     4.1.4 Project Structure Settings ....................................................... 13
     4.1.5 Target Project Settings ............................................................ 13
     4.1.6 Table Sheet Info ...................................................................... 13

## 5 Structure of the Typical File ................................................................. 14
  5.1 Table Sheet <Typical name> ............................................................. 14
     5.1.1 Column Headers and Column Contents .................................... 15

## 6 Macro Preparation .................................................................................... 20

## 7 Macro Placement on Schematic Pages ................................................... 21
  7.1 Page macros ...................................................................................... 21
     7.1.1 Single Page ............................................................................. 21
     7.1.2 Multiple Pages ......................................................................... 21
  7.2 Window Macros ................................................................................. 22
     7.2.1 Generating a Schematic Page for Each Window Macro ............... 22
     7.2.2 Placing Multiple Window Macros on a Schematic Page at the Same Time ......................................................... 23
     7.2.3 Continue with the Structure Identifier and / or Page Names of the Previous Window Macro ......................................................... 23
     7.2.4 Adopting Full Page Name and Page Properties from a Page Macro ................................................................. 24

## 8 Macro Placement and Orientation .......................................................... 25
  8.1 Orientation Without Coordinates ...................................................... 25
     8.1.1 Place Macros Below Each Other ................................................ 25
     8.1.2 Place Macros on Existing Page .................................................. 25
     8.1.3 Orientation to the X-Coordinate ................................................ 26
8.1.4  Orientation to the [Y] Coordinate ............................................................ 29
8.1.5  Orientation to the X- and Y-Coordinates .................................................. 32
8.1.6  Reset the Macro Placement .................................................................. 34

9  Swapping Symbol Representation Types ...................................................... 35
10  Swapping Macro Variant............................................................................. 36
11  Syntax for Function Groups and Functions................................................ 37
12  Syntax for Calculation Variables .................................................................. 38
    12.1  Calculation types................................................................................. 39
    12.1.1  Increment......................................................................................... 39
    12.1.2  Decrement....................................................................................... 39
    12.1.3  PLC Addressing 8 bit Digital ............................................................ 39
    12.1.4  PLC Addressing 16 bit Digital .......................................................... 39
    12.1.5  PLC Addressing Analog ................................................................. 39
    12.1.6  Number Blockwise ......................................................................... 39

13  Rules for Formatting / Data Entry in the Typical File .................................. 41
14  Meaning of Colors of the Typical File......................................................... 42
15  Command Line Parameters ......................................................................... 43
16  Installing EEC One ...................................................................................... 44
17  Starting EEC One ......................................................................................... 45
18  Adjusting the Security Level for Excel Macros ........................................... 46
19  Show EEC One Ribbon ............................................................................... 47
20  Configure the EEC One-Excel-Editor ........................................................... 48
    20.1  Define EEC One Settings ..................................................................... 48
    20.2  Define the EPLAN Electric P8 / EPLAN Fluid Version ..................... 48
    20.3  Define the Typical .............................................................................. 48
    20.4  Defining the Project Structure .............................................................. 49
    20.5  Define the Target Project .................................................................... 49
21  Edit the Typical file ..................................................................................... 50
    21.1  Open Typical File .............................................................................. 50
    21.2  Define the Typical Name ..................................................................... 50
    21.3  Entering a Typical Worksheet Identifier ............................................ 50
    21.4  Use Drag & Drop to Enter a Macro Name Into the Typical File .......... 50
    21.5  Display the Entered Macro in the Macro Preview ................................ 51
    21.6  Automatically Enter Placeholder Object Variables ........................... 51
    21.7  Changing the Sequence of the Variable Columns .............................. 51
    21.8  Deactivate a Macro ............................................................................ 52
22  Defining Structure Identifiers and Page Names in the Typical File .............. 53
23  Defining Macro Placement in the Typical File ............................................ 54
    23.1  Place Macros Next to Each Other ....................................................... 54
    23.2  Place Macros Below Each Other ........................................................ 54
    23.3  Place Each Macro at its Own X- and Y-Coordinates ........................... 55
24 Generating Schematic Pages with EEC One ................................................................. 56
   24.1 Generate a Schematic from a Typical ................................................................. 56
   24.2 Generate Schematics from Several Table Sheets ............................................... 56
25 EEC One Ribbon ........................................................................................................... 57
   25.1 Dialog Preview / Macro Selection - <Project name>............................................. 57
   25.2 Dialog Generate / Typical ..................................................................................... 58
   25.3 Dialog Variables <Table Page name> ................................................................. 59
   25.4 Dialog Rule <Rule name> .................................................................................... 59
26 Index ............................................................................................................................. 61
EPLAN Engineering Center One

The EPLAN Engineering Center One (EEC One) allows you to automatically create schematics for EPLAN Electric P8 and EPLAN Fluid projects on the basis of standardized partial circuits (schematic macros) and table-based project-specific information.

Templates for the standards that are to be defined are recurring functions of machines and plants, which are modeled as partial circuits and functions in schematic macros.

The project-specific information and data is collected in a table structure - the so-called Typical table.

In another step in the EEC One, the project data is linked to the partial circuits in this Typical table. The EEC One combines project data and schematic macros and prepares the resulting schematic documentation in EPLAN.

The EEC One consists of three main elements:

- **EEC One-Module**: The EEC One-Module automatically generates schematic pages based on macros and a Typical file.
- **Typical File**: In the Typical file you enter information on the macros to be used for schematic generation, e.g., macro names, control commands, and project data.
- **EEC One-Excel-Editor**: You use the EEC One-Excel-Editor to configure the Typical file and control the EEC One-Module.

You can open the EEC One-Excel-Editor by starting the EEC One-Excel-Editor.xlsm, for example from the folder C:\Programs (x86)\EPLAN\EECOne\<Version number>, in an Excel application. The EEC One-Module is automatically started when generating the schematics.
The individual function ranges of EEC One, which are necessary for this task, are listed in the following overview of functions.

<table>
<thead>
<tr>
<th>Function</th>
<th>Available</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameterizing of macros via placeholder technology</td>
<td>✓</td>
</tr>
<tr>
<td>Controlling placing options of macros of the EPLAN platform</td>
<td>✓</td>
</tr>
<tr>
<td>Creating a Typical file</td>
<td>✓</td>
</tr>
<tr>
<td>Front-end based on Excel (configuration tool)</td>
<td>✓</td>
</tr>
<tr>
<td>Using structure identifiers</td>
<td>✓</td>
</tr>
<tr>
<td>Macro preview</td>
<td>✓</td>
</tr>
<tr>
<td>Macro selection</td>
<td>✓</td>
</tr>
<tr>
<td>Parameter transfer (placeholder) from macros</td>
<td>✓</td>
</tr>
<tr>
<td>Checking the macros</td>
<td>✓</td>
</tr>
<tr>
<td>Handling of functions and function groups by Excel</td>
<td>✓</td>
</tr>
<tr>
<td>Controlling of value sets in macros</td>
<td>✓</td>
</tr>
<tr>
<td>Controlling of different variants in a macro</td>
<td>✓</td>
</tr>
<tr>
<td>Controlling of different representation types in a macro</td>
<td>✓</td>
</tr>
<tr>
<td>Using of existing scripts from the EPLAN platform</td>
<td>✓</td>
</tr>
<tr>
<td>Updating of predefined reports in the EPLAN Platform</td>
<td>✓</td>
</tr>
</tbody>
</table>

1.1 Typical

Circuits are split into partial circuits to allow the flexible creation of job-specific documents and to allow the re-use of standardized functions for machines and plants. Depending on the job, these partial circuits are combined and parameterized to form the job-specific plant / machine (variants project). This combination and parameterization of partial circuits is called Typical.

1.2 Macros and Placeholder Objects

The partial circuits are created in a structured manner in a macro project and clearly documented. Macros are generated from the partial circuits. To allow re-use of a macro for different variant projects, variables are stored in the macro via placeholder objects. The variables are replaced with different values on schematic generation.
2 General Requirements

2.1 Recommended Workstation Configuration

<table>
<thead>
<tr>
<th></th>
<th>Recommendation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>Comparable to an Intel Pentium D at 3 GHz</td>
</tr>
<tr>
<td></td>
<td>Comparable to an Intel Core 2 Duo at 2.4 GHz</td>
</tr>
<tr>
<td>RAM</td>
<td>4 GB *1</td>
</tr>
<tr>
<td>Hard disk</td>
<td>160 GB</td>
</tr>
<tr>
<td>Monitor / graphics resolution</td>
<td>2-screen solution 21” or 16:10 graphics system with a resolution of 1680 x 1050</td>
</tr>
<tr>
<td>3D display</td>
<td>Graphics card from ATI or NVIDIA with the latest OpenGL driver</td>
</tr>
</tbody>
</table>

*1: Individual functions like PDF or DXF output require more memory in connection with large projects or very extensive graphics.

2.2 Network

Operate the server only with Microsoft Windows operating system.

<table>
<thead>
<tr>
<th>Network transfer rate of the server</th>
<th>1 Gbits/s</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network transfer rate of the client computer</td>
<td>100 Mbits/s</td>
</tr>
<tr>
<td>Recommended latency</td>
<td>&lt; 1ms</td>
</tr>
</tbody>
</table>

2.3 Operating Systems

EPLAN recommends that a 64 bit Windows operating system is used.

The program is released for the following operating systems:

2.3.1.1 Workstation

- Microsoft Windows XP Professional SP3 (32 bit)
- Microsoft Windows Vista SP2 (32 bit and 64 bit) Enterprise, Business N, Ultimate
- Microsoft Windows 7 SP1 (32 bit and 64 bit) Professional, Enterprise, Ultimate

2.3.1.2 Server

- Microsoft Windows Server 2003 SP2 (32 bit and 64 bit)
- Microsoft Windows Server 2008 SP2 (32 bit and 64 bit)
- Microsoft Windows Server 2008 RC2 (64 bit)

2.4 EPLAN Products

- EPLAN Electric P8 (Professional and Select) Version 2.1, 2.1 SP1, 2.2
- EPLAN Fluid Version 2.1, 2.1 SP1, 2.2
2.5 Microsoft Products

- Microsoft Office 2007 (32 Bit)
- Microsoft Office 2010 (32 bit)
## 3 Files and Folders

The following table shows the most important files and folders that you need for working with EEC One.

<table>
<thead>
<tr>
<th>File/Folder</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>EECOne_Excel_Editor.xlsm</strong></td>
<td>Start file of the EEC One-Excel-Editor. After a standard installation, this file is located in the <code>C:\Programs (x86)\EPLAN\EECOne\&lt;Version number&gt;</code> folder. In this file you define the basic folders and files needed by the EEC One for generating schematics. You also control the schematic generation via this file. Structure of the EEC One Excel Editor Configuring the EEC One Excel Editor</td>
</tr>
<tr>
<td><strong>typical.xlsx</strong></td>
<td>Template for a Typical file. In the Typical file you enter information on the macros to be used for schematic generation. The Typical file must be located in the <code>*.edb</code> EPLAN project folder of the target project. When you first use EEC One, then a Typical file does not yet exists in the EPLAN project folder. When the EEC One-Excel-Editor is started, the assigned Typical file is opened. Structure of the Typical File Configure the Typical file</td>
</tr>
<tr>
<td><strong>typical.xltx</strong></td>
<td>Template file for a Typical file. After a standard installation, this is located in the <code>C:\Programs (x86)\EPLAN\EECOne\&lt;Version number&gt;\Templates folder</code>. The Typical file is created by double-clicking the template file. This file is added to the personal templates by copying it to the folder <code>C:\Users\&lt;User name&gt;\AppData\Roaming\Microsoft\Templates</code>.</td>
</tr>
<tr>
<td><strong>typical.txt</strong></td>
<td>Internal transfer file. When generating schematics, the data from the <code>typical.xlsx</code> file is output to a <code>typical.txt</code> file. You can use the <code>typical.txt</code> file to directly output data to this file. The <code>typical.txt</code> file has a tab-delimited structure. The contents, e.g., control commands for macro placement, are similar to the Typical file.</td>
</tr>
<tr>
<td><strong>typical.log</strong></td>
<td>Saves messages, which have been created during generating, if the logging level Messages, Warnings or Errors has been selected. This is located in the target project folder.</td>
</tr>
<tr>
<td><strong>EECOne.exe</strong></td>
<td>Start file of the EEC One-Module. Automatically generates schematic pages based on macros and a Typical file. You control the EEC One-Module via the command line.</td>
</tr>
<tr>
<td><strong>EECOne.chm</strong></td>
<td>Help file of EEC One. Can be found for the installed language in a subfolder with the international language abbreviation, e.g. <code>C:\Programs (x86)\EPLAN\EECOne\&lt;Version number&gt;\en-US</code> for US English.</td>
</tr>
</tbody>
</table>
4 Structure of the EEC One-Excel-Editor

The EECOne_Excel_Editor.xlsm file is the start file of the EEC One-Excel-Editor, which you open in the Microsoft Excel application. In the EEC One-Excel-Editor you can define the basic folders and files that are needed by the EEC One for generating schematics. You also use this for controlling the schematic generation.

In addition to the standard Excel functions, the EEC One-Excel-Editor contains the EEC One ribbon, the Table Sheet Settings and the Table Sheet Info.

4.1 Table Sheet Settings

4.1.1 EEC One Settings

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Language</td>
<td>Shows the current dialog language of the EEC One-Excel-Editor. Other dialog languages are available in the drop-down list. Messages, which are stored in a log file, will only be shown when generating in the newly chosen language.</td>
</tr>
<tr>
<td>Version</td>
<td>Shows the current version of EEC One.</td>
</tr>
<tr>
<td>File name</td>
<td>Shows the file name of the open EEC One-Excel-Editor.</td>
</tr>
<tr>
<td>Program folder</td>
<td>Shows the folder containing the EECOne_Excel_Editor.xlsm file after installation.</td>
</tr>
<tr>
<td>Logging level</td>
<td>Defines the message categories to be output to a log file. The following message categories are available: No messages, Messages, Warnings, Errors.</td>
</tr>
<tr>
<td>Show log</td>
<td>Defines whether the Typical.log message file is shown after the generating run. The software, which is allocated to the .log ending, e.g. Notepad.exe, is used for displaying.</td>
</tr>
<tr>
<td>Scale macros according to the page scale</td>
<td>Defines whether the macro scaling is adapted to the scaling factor of the page.</td>
</tr>
</tbody>
</table>

4.1.2 EPLAN Electric P8 Settings

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Program folder</td>
<td>The drop-down list shows all EPLAN Electric P8 or EPLAN Fluid versions that are installed on your system and which can be used with the EEC One. Select a version.</td>
</tr>
<tr>
<td>Version</td>
<td>Shows the program version of EPLAN Electric P8 or EPLAN Fluid that you have selected in the Program folder field.</td>
</tr>
<tr>
<td>Macro folder</td>
<td>Automatically shows the EPLAN macro folder of the program version that you have selected in the Program folder field. Click [...] to select a different macro folder. If a macro folder is specified, then the macro names do not need to be entered with full paths in the Typical file. EPLAN accesses this folder to find the macros for the current project.</td>
</tr>
</tbody>
</table>
### 4.1.3 Typical Settings

<table>
<thead>
<tr>
<th><strong>File path</strong></th>
<th>Indicates the path to the TYPICAL file of the EPLAN project. Using [...] you open a file selection dialog. Select a file of the EEC ONE Typical Template (*.xlsx) file type, e.g. typical.xlsx from the C:\Programs (x86)\EPLAN\EECOne&lt;Version number&gt;\Templates folder, and click on [Open].</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Typical worksheet identifier</strong></td>
<td>The Typical worksheet identifier is located in the first table cell of the Typical file (table column A / table row 1), e.g. <strong>TYPICAL X</strong> or <strong>TYPICAL EEC</strong>. It marks the table sheet in the *.xlsx file as Typical. The Typical worksheet identifier also identifies a table row as a header row. All values in the row containing the Typical worksheet identifier are headings. These values are not reported.</td>
</tr>
</tbody>
</table>
| **Separator for function groups** | Function names and the associated function groups are distinguished by the separator that you enter here. The default separator is @. You can divide the data in the Typical file into function groups and functions. When each table sheet represents a function then the table sheet name reflects the function name. You identify associated table sheets by inserting the function group name in front of the function name in the table sheet names.  
**Example:**
FunctiongroupA@Function1
FunctiongroupA@Function2 |
| **Start row** | You enter the row number of the first data row in the Typical file here. Example: The first table row is the header row. The header row contains the Typical worksheet identifier and the names of the columns. The second table row is the first data row. Data rows contain values, macro names, and control commands. You therefore enter the value 2 here. |
| **Start column** | Here you can enter the column number of the first table column of the Typical file, where the variables of the placeholder objects are entered during the automatic loading process. The column ! (column for deactivating / commenting) and the X/Y-columns must be within the defined area of the start column. |
| **Ladder column name** | Here you can enter the name for the column, where the number of ladders (ladder systems) must be indicated. This only applies to projects, which are created according to the JIC standard. |
| **Measuring unit** | Select the measuring unit, which is to be used for the project, from the drop-down list. |
### 4.1.4 Project Structure Settings

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Functional assignment</td>
<td>The drop-down list can be used here to define whether the <strong>Functional assignment</strong> identifier block is available in the Typical file or not. If you select the <strong>Not available</strong> entry then the corresponding column is not displayed. This setting affects all Typical files in the * .edb EPLAN project folder.</td>
</tr>
<tr>
<td>Higher-level function</td>
<td>The drop-down list can be used here to define whether the <strong>Higher-level function</strong> identifier block is available in the Typical file or not. If you select the <strong>Not available</strong> entry then the corresponding column is not displayed. This setting affects all Typical files in the * .edb EPLAN project folder.</td>
</tr>
<tr>
<td>Installation site</td>
<td>The drop-down list can be used here to define whether the <strong>Installation site</strong> identifier block is available in the Typical file or not. If you select the <strong>Not available</strong> entry then the corresponding column is not displayed. This setting affects all Typical files in the * .edb EPLAN project folder.</td>
</tr>
<tr>
<td>Mounting location</td>
<td>The drop-down list can be used here to define whether the <strong>Mounting location</strong> identifier block is available in the Typical file or not. If you select the <strong>Not available</strong> entry then the corresponding column is not displayed. This setting affects all Typical files in the * .edb EPLAN project folder.</td>
</tr>
<tr>
<td>Higher-level function number</td>
<td>The drop-down list can be used here to define whether the <strong>Higher-level function number</strong> identifier block is available in the Typical file or not. If you select the <strong>Not available</strong> entry then the corresponding column is not displayed. This setting affects all Typical files in the * .edb EPLAN project folder.</td>
</tr>
<tr>
<td>Document type</td>
<td>The drop-down list can be used here to define whether the <strong>Document type</strong> identifier block is available in the Typical file or not. If you select the <strong>Not available</strong> entry then the corresponding column is not displayed. This setting affects all Typical files in the * .edb project folder.</td>
</tr>
<tr>
<td>User-defined</td>
<td>The drop-down list can be used here to define whether the <strong>User-defined</strong> identifier block is available in the Typical file or not. If you select the <strong>Not available</strong> entry then the corresponding column is not displayed. This setting affects all Typical files in the * .edb project folder.</td>
</tr>
<tr>
<td>Page name</td>
<td>The drop-down list can be used here to define whether the <strong>Page name</strong> identifier block is available in the Typical file or not. If you select the <strong>Not available</strong> entry then the corresponding column is not displayed. This setting affects all Typical files in the * .edb project folder.</td>
</tr>
</tbody>
</table>

### 4.1.5 Target Project Settings

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File path</td>
<td>Allows selection of an EPLAN Electric P8 or EPLAN-Fluid project (*.elk) as the target project. The schematics are automatically output to this project. Using [...] you open a file selection dialog. Select an *.elk target project, e.g. from the C: \ Users \ Public \ EPLAN \ Electric P8 \ &lt;Version number&gt; \ Projects \ &lt;Company code&gt; \ folder.</td>
</tr>
<tr>
<td>Project name</td>
<td>Shows the project name of the project that you selected in the <strong>File path</strong> field. This project is the output project for EEC One.</td>
</tr>
<tr>
<td>Version</td>
<td>Shows the program version with build number.</td>
</tr>
</tbody>
</table>

### 4.1.6 Table Sheet Info

You can specify extra information here.
5 Structure of the Typical File

A Typical file, e.g. typical.xlsx, consists of one or more table sheets. One table sheet corresponds to one Typical. Enter a name for the Typical in the table sheet name (see also Function groups).

The *.xlsx Typical file is opened in the Microsoft Excel application. In addition to the standard Excel functions, the *.xlsx Typical file contains the EEEC One ribbon and at least one Table sheet <Typical name>.

5.1 Table Sheet <Typical name>

A table sheet in the Typical file consists of table columns and table rows. The table rows can be either heading rows or data rows. The heading rows contain the names of the columns. The data rows contain all necessary values, macro names, and control commands.
### 5.1.1 Column Headers and Column Contents

The (first) header row begins in the first table row. The sequence of columns 2 to 9 is predefined. This is followed by columns where the macro variables are entered and by user-defined columns. The data rows begin at the second table row.

<table>
<thead>
<tr>
<th>TYPICAL X</th>
<th>Column / Column header:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The column header contains the <code>&lt;Typical worksheet&gt;</code> identifier column. This identifies the table sheet as a valid Typical. This is the case when the column name and the entry in the <code>Typical worksheet identifier</code> field of the EEC One-Excel-Editor are identical.</td>
</tr>
<tr>
<td></td>
<td>Default is <code>TYPICAL X</code>.</td>
</tr>
<tr>
<td></td>
<td>If representation types and macro variants are used, the <code>TYPICAL EEC</code> column header must be used.</td>
</tr>
<tr>
<td></td>
<td><strong>Column contents:</strong></td>
</tr>
<tr>
<td></td>
<td>Contains macro names without a file suffix. Depending on the storage location of the macro and the specified macro folder, the macro name is entered with or without a path. All macros are placed in the schematics in the order of window macro &gt; page macro &gt; symbol macro.</td>
</tr>
<tr>
<td></td>
<td>Use Drag &amp; Drop to Enter a Macro Name Into the Typical File</td>
</tr>
<tr>
<td></td>
<td>Contains control commands for Macro Placement.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Functional assignment</th>
<th>Column / Column header:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>This column is only displayed, if you have selected the <code>Available</code> entry in the <code>Functional assignment</code> field of the EEC One-Excel-Editor. The column header is permanently defined.</td>
</tr>
<tr>
<td></td>
<td><strong>Column contents:</strong></td>
</tr>
<tr>
<td></td>
<td>Contains the structure identifier for the <code>Functional assignment</code> identifier block of the associated macro.</td>
</tr>
<tr>
<td></td>
<td>Rules for Data Entry in the Typical File</td>
</tr>
<tr>
<td></td>
<td>Defining Structure Identifiers and Page Names in the Typical File</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Higher-level function</th>
<th>Column / Column header:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>This column is only displayed, if you have selected the <code>Available</code> entry in the <code>Higher-level function</code> field of the EEC One-Excel-Editor. The column header is permanently defined.</td>
</tr>
<tr>
<td></td>
<td><strong>Column contents:</strong></td>
</tr>
<tr>
<td></td>
<td>Contains the structure identifier for the <code>Higher-level function</code> identifier block of the associated macro.</td>
</tr>
<tr>
<td></td>
<td>Rules for Data Entry in the Typical File</td>
</tr>
<tr>
<td></td>
<td>Defining Structure Identifiers and Page Names in the Typical File</td>
</tr>
</tbody>
</table>
| **Installation site** | **Column / Column header:**  
|-----------------------|--------------------------------------------------------------------------------  
|                       | This column is only displayed, if you have selected the **Available** entry in the **Installation site** field of the EEC One-Excel-Editor. The column header is permanently defined.  
| **Column contents:**  | Contains the structure identifier for the "Installation site" identifier block of the associated macro.  
|                       | [Rules for Data Entry in the Typical File](#)  
|                       | [Defining Structure Identifiers and Page Names in the Typical File](#)  
| **Mounting location** | **Column / Column header:**  
|-----------------------|--------------------------------------------------------------------------------  
|                       | This column is only displayed, if you have selected the **Available** entry in the **Mounting location** field of the EEC One-Excel-Editor. The column header is permanently defined.  
| **Column contents:**  | Contains the structure identifier for the **Mounting location** identifier block of the associated macro.  
|                       | [Rules for Data Entry in the Typical File](#)  
|                       | [Defining Structure Identifiers and Page Names in the Typical File](#)  
| **Higher-level function number** | **Column / Column header:**  
|-----------------------|--------------------------------------------------------------------------------  
|                       | This column is only displayed, if you have selected the **Available** entry in the **Higher-level function number** field of the EEC One-Excel-Editor. The column header is permanently defined.  
| **Column contents:**  | Contains the structure identifier for the **Higher-level function number** identifier block of the associated macro.  
|                       | [Rules for Data Entry in the Typical File](#)  
|                       | [Defining Structure Identifiers and Page Names in the Typical File](#)  
| **Document type** | **Column / Column header:**  
|-----------------------|--------------------------------------------------------------------------------  
|                       | This column is only displayed, if you have selected the **Available** entry in the **Document type** field of the EEC One-Excel-Editor. The column header is permanently defined.  
| **Column contents:**  | Contains the structure identifier for the **Document type** identifier block of the associated macro.  
|                       | [Rules for Data Entry in the Typical File](#)  
|                       | [Defining Structure Identifiers and Page Names in the Typical File](#)  

---

[Rules for Data Entry in the Typical File](#)

[Defining Structure Identifiers and Page Names in the Typical File](#)
<table>
<thead>
<tr>
<th>Column / Column header:</th>
<th>This column is only displayed, if you have selected the Available entry in the User-defined field of the EEC One-Excel-Editor. The column header is permanently defined.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column contents:</td>
<td>Contains the structure identifier for the User-defined identifier block of the associated macro.</td>
</tr>
<tr>
<td>Rules for Data Entry in the Typical File</td>
<td>Defining Structure Identifiers and Page Names in the Typical File</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Column / Column header:</th>
<th>This column is only displayed, if you have selected the Available entry in the Page name field of the EEC One-Excel-Editor. The column header is permanently defined.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column contents:</td>
<td>If page names are defined in the macro project then these can be adopted by using an entry of 0 in the table. You can also enter any desired page name to overwrite the page number of the macro. If the table cell remains empty, then the last defined page number of the cell above is used.</td>
</tr>
<tr>
<td>Rules for Data Entry in the Typical File</td>
<td>Defining Structure Identifiers and Page Names in the Typical File</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Column / Column header:</th>
<th>This column must be inserted manually if macros with a representation type are to be used. The column header is not permanently defined.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column contents:</td>
<td>If a window macro with different representation types has been created, the representation type is shown as a numerical value:</td>
</tr>
<tr>
<td>1 = Multi-line</td>
<td>2 = Single-line</td>
</tr>
<tr>
<td>3 = Pair cross-reference</td>
<td>4 = Overview</td>
</tr>
<tr>
<td>5 = Part placement</td>
<td>6 = Multi-line Fluid</td>
</tr>
<tr>
<td>7 = PI diagram</td>
<td></td>
</tr>
<tr>
<td>Rules for Data Entry in the Typical File</td>
<td>Defining Structure Identifiers and Page Names in the Typical File</td>
</tr>
</tbody>
</table>
### Variant (only for TYPICAL EEC)

**Column / Column header:**
This column must be inserted manually if macros with variants are to be used. The column header is not permanently defined.

**Column contents:**
If a window macro with different variants has been created, the variant is shown as a capital letter.
- Variant A = A
- Variant B = B
etc.

Values from A to P, such as in EPLAN Electric P8, can be stated. There will be no check in the EEC One-Excel-Editor. If a wrong value is detected during generating, an error message is created.

### !

**Column / Column header:**
The column header is permanently defined.

**Column contents:**
Column for deactivating / commenting. When a cell in this column contains a ! character, then the entire row is regarded as a comment row, i.e., the row is ignored during schematic generation. The cells in the variable column are then not color coded. You can use this column to convert a macro entry into a comment or to insert a comment row between the macro entries.

### X

**Column / Column header:**
This column is optional. The column header is predefined. You can manually insert this column to orient macros to X and Y coordinates and place them at specific positions.

**Column contents:**
Contains the value for the X-coordinate.

*Rules for Data Entry in the Typical File*

Orientation to the X- and Y-coordinate

### Y

**Column / Column header:**
This column is optional. The column header is predefined. You can manually insert this column to orient macros to X and Y coordinates and place them at specific positions.

**Column contents:**
Contains the value for the X-coordinate.

*Rules for Data Entry in the Typical File*

Orientation to the X- and Y-coordinate

### All other columns
| **Variables in the macro placeholder object** | **Column / Column header:**
The variables from the macro placeholder objects are automatically entered into these column headers.  
[Read out variables from the macro placeholder object](#)  
**Column contents:**  
Contains the value for the variant project.  
[Rules for Data Entry in the Typical File](#) |
| --- | --- |
| **Calculation variables in the macro placeholder object** | **Column / Column header:**
The calculation variables from the macro placeholder objects are automatically entered into these column headers.  
[Syntax for Calculation Variables](#)  
**Column contents:**  
Contains the value for the variant project.  
[Rules for Data Entry in the Typical File](#) |
6 Macro Preparation

Ideally you create your macros in a macro project. This has the advantage that you can create macros automatically from the entire macro project with a single action.
7 Macro Placement on Schematic Pages

7.1 Page macros

7.1.1 Single Page

In the EEC One you can create schematic pages from page macros, which contain only a single page. You will need to state the full page name for the new schematic page in the target project. This page name consists of a structure identifier and page name (e.g. DOC/O1/1). The new schematic page (e.g. DOC/O1/1) is created from the page macro.

![Figure 7-1: A page macro for a schematic page](image)

7.1.2 Multiple Pages

In the EEC One you can create schematic pages from page macros, which contain multiple pages. A page macro contains multiple pages if you highlight several pages in the page navigator of EPLAN Electric P8 and create a page macro via Context menu > Create page macro.
You will need to state the full page name for the new schematic page in the target project. This page name consists of a structure identifier and page name (e.g. DOC/O1/1). This schematic page is created from the first macro page. All other pages of the page macro are inserted after that.

If **Page 0** is stated in the column, the page structure from the page macro is copied in the same manner, in which it was created for the page macro.

### 7.2 Window Macros

You can create schematic pages from window macros alone. It is possible to create a schematic page from each window macro and to place all window macros on a schematic page.

#### 7.2.1 Generating a Schematic Page for Each Window Macro

If each window macro has been allocated its own page name, each window macro is placed on its own schematic page.

<table>
<thead>
<tr>
<th>Window macro 1</th>
<th>Functional assignment</th>
<th>Higher-level function</th>
<th>Mounting location</th>
<th>Page name</th>
</tr>
</thead>
<tbody>
<tr>
<td>DOC 01 1</td>
<td>PLC</td>
<td>EAA</td>
<td></td>
<td>!</td>
</tr>
</tbody>
</table>

**Figure 7-3:** One schematic page for each window macro

Example:

- Window macro `BK3100.ema` is placed on page `=PLC+EAA/1` at the original insertion point.
- Window macro `BK3200.ema` is placed on page `=PLC+EAA/2` at the original insertion point.
- Window macro `BK3300.ema` is placed on page `=PLC+EAA/3` at the original insertion point.
7.2.2 Placing Multiple Window Macros on a Schematic Page at the Same Time

If each window macro has been allocated the same page name, all window macros are placed on the same schematic page. There will be no check for overlapping of macros.

<table>
<thead>
<tr>
<th>Window macro 1</th>
<th>DOC</th>
<th>01</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Window macro 2</td>
<td>DOC</td>
<td>01</td>
<td>1</td>
</tr>
<tr>
<td>Window macro 3</td>
<td>DOC</td>
<td>01</td>
<td>1</td>
</tr>
</tbody>
</table>

Figure 7-4: Placing multiple window macros on a schematic page

Example:

The following table shows a section of a Typical file.

<table>
<thead>
<tr>
<th></th>
<th>Typical worksheet identifier</th>
<th>Higher-level function</th>
<th>Mounting location</th>
<th>Page name</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>BK3100</td>
<td>PLC</td>
<td>EAA</td>
<td>1</td>
</tr>
<tr>
<td>3</td>
<td>BK3200</td>
<td>PLC</td>
<td>EAA</td>
<td>1</td>
</tr>
<tr>
<td>4</td>
<td>BK3300</td>
<td>PLC</td>
<td>EAA</td>
<td>1</td>
</tr>
</tbody>
</table>

- Window macro BK3100.ema is placed on page =PLC+EAA/1 at the original insertion point.
- Window macro BK3200.ema is placed on page =PLC+EAA/1 at the original insertion point.
- Window macro BK3300.ema is placed on page =PLC+EAA/1 at the original insertion point.

7.2.3 Continue with the Structure Identifier and / or Page Names of the Previous Window Macro

If the structure identifier and/or page name in the Typical file are only entered for the first window macro, these entries are continued for the underlying macros.

<table>
<thead>
<tr>
<th>Window macro 1</th>
<th>DOC</th>
<th>01</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Window macro 2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Window macro 3</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Figure 7-5: Continue the structure identifier of the first window macro for the following
The following table shows a section of a Typical file.

<table>
<thead>
<tr>
<th></th>
<th>Typical worksheet identifier</th>
<th>Higher-level function</th>
<th>Mounting location</th>
<th>Page name</th>
<th>!</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>BK3100</td>
<td>PLC</td>
<td>EAA</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>BK3200</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>BK3300</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- Window macro BK3100.ema is placed on page =PLC+EAA/1 at the original insertion point.
- Window macro BK3200.ema is placed on page =PLC+EAA/1 at the original insertion point.
- Window macro BK3300.ema is placed on page =PLC+EAA/1 at the original insertion point.

7.2.4 Adopting Full Page Name and Page Properties from a Page Macro

You can create schematic pages from the combination of page macros and window macros. Hereby you define page properties in an empty schematic page and create a page macro from this schematic page. If you do not specify a full page name for the window macros, a schematic page is created from the page macro, on which the window macros will be placed. The new schematic page is automatically given the page properties from the page macro.

Figure 7-6: Page macro and window macros create a schematic page with placed macros

Example:

The following table shows a section of a Typical file.

You have manually created an empty schematic page in the EPLAN page navigator and entered the value of a page property.

<table>
<thead>
<tr>
<th></th>
<th>Typical worksheet identifier</th>
<th>Higher-level function</th>
<th>Mounting location</th>
<th>Page name</th>
<th>!</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Empty Page macro</td>
<td>PLC</td>
<td>EAA</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>###</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>BK3200</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>BK3300</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- The =PLC+EAA/1 schematic page is created from the Empty Page macro page macro. The new =PLC+EAA/1 schematic page contains the page properties from the page macro.
- Window macro BK3200.ema is placed on page =PLC+EAA/1 at the original insertion point.
- Window macro BK3300.ema is placed on page =PLC+EAA/1 at the original insertion point.
8 Macro Placement and Orientation

You can use control commands for the orientation in order to specify whether macros are placed at their original insertion point next to each other, below each other or in an absolute position.

8.1 Orientation Without Coordinates

If window macros without control command for the orientation are entered in the Typical file, all macros are placed at their original insertion point.

![Figure 8-1: Orientation of macros without Coordinates](image)

**Example:**

The following table shows a section of a Typical file.

<table>
<thead>
<tr>
<th></th>
<th>Typical worksheet identifier</th>
<th>Higher-level function</th>
<th>Mounting location</th>
<th>Page name</th>
<th>!</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>BK3100</td>
<td>PLC</td>
<td>EAA</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>BK3200</td>
<td>PLC</td>
<td>EAA</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>BK3300</td>
<td>PLC</td>
<td>EAA</td>
<td>1</td>
<td></td>
</tr>
</tbody>
</table>

- Window macro BK3100.ema is placed on page =PLC+EAA/1 at the original insertion point.
- Window macro BK3200.ema is placed on page =PLC+EAA/1 at the original insertion point.
- Window macro BK3300.ema is placed on page =PLC+EAA/1 at the original insertion point.

8.1.1 Place Macros Below Each Other

Several macros are placed above each other if they have the identical structure identifiers, e.g. for plant and installation location, and identical page names in the Excel table. Ideally you have created macros with macro boxes via a macro project. The way, in which the macros are placed above each other when the schematics are created, depends on the insertion point of the macro boxes. This feature is especially useful when individual functions or function groups only occasionally occur in variants and must therefore be "hooked-up" as required.

8.1.2 Place Macros on Existing Page

You can place macros on an existing page without changing the existing page properties, switching symbols and page elements.

<table>
<thead>
<tr>
<th>Place Macros on Existing Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>This command allows you to place macros on an existing page. Page properties, switching symbols and page elements, which are already on the page, will not be changed. Macros are added automatically.</td>
</tr>
</tbody>
</table>
### Place Macros on Existing Page

<table>
<thead>
<tr>
<th>Control command syntax</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>#### [+]</td>
<td></td>
</tr>
</tbody>
</table>

#### 8.1.3 Orientation to the X-Coordinate

If you orient your macro to the X-coordinate when placing it, the first macro is placed at its original insertion point and all further macros are placed next to it in X-direction.

You can use the X-coordinate to define the offset between the macros in X-direction if they are placed next to each other. You control the placement by entering the following control commands into the first `<Typical worksheet identifier>` column in the Typical file.

<table>
<thead>
<tr>
<th>Orientation to the X-coordinate</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Description</strong></td>
</tr>
</tbody>
</table>
| **Control command syntax** | #### [X]  
|                           | or  
|                           | #### [X=16] |

**Note:**

You should be aware of the fact that the number of macros that can be placed next to each other on a schematic page is limited. When too many macros are placed next to each other then the macros are placed outside the plot frame.

#### 8.1.3.1 Place Macros Next to Each Other

The #### [x] control command allows you to place macros immediately next to each other without any offset (distance between them).

Figure 8-2: Placing macros immediately next to each other without any offset, schematic view
Figure 8-3: Place Macros Next to Each Other

Example:

The following table shows a section of a Typical file.

<table>
<thead>
<tr>
<th></th>
<th>Typical worksheet identifier</th>
<th>Higher-level function</th>
<th>Mounting location</th>
<th>Page name</th>
<th>!</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>###[x]</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>BK3100</td>
<td>PLC</td>
<td>EAA</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>BK3200</td>
<td>PLC</td>
<td>EAA</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>BK3300</td>
<td>PLC</td>
<td>EAA</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>###</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- ###[x]: Control command to orient the macros to the X-coordinate. The X-coordinate contains no value. The control command is valid for the window macros: BK3100.ema, BK3200.ema, BK3300.ema.
- Window macro BK3100.ema is placed on page =PLC+EAA/1 at the original insertion point.
- Window macro BK3200.ema is placed on page =PLC+EAA/1 in X direction next to the previous macro BK3100.ema. Its X position is determined from the coordinates of the previous macro plus its width. Its Y-position is adopted from the placed macro.
- Window macro BK3300.ema is placed on page =PLC+EAA/1 in X direction next to the previous macro BK3200.ema. Its X position is determined from the coordinates of the previous macro plus its width. Its Y-position is adopted from the placed macro.
- The ### control command ends the mode for orienting the macro to the Y-coordinate.
8.1.3.2 Placing Macros Next to Each Other With an Offset

If you use the `####[x]` control command to allocate a value to the X-coordinate, for example `####[x=16]`, you can place macros next to each other with a defined offset (distance between them).

![Diagram of macros placed next to each other with an offset](image)

Figure 8-4: Placing macros next to each other with an offset, schematic view

<table>
<thead>
<tr>
<th><code>####[x=16]</code></th>
<th>DOC</th>
<th>01</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Window macro 1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Window macro 2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Window macro 3</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Figure 8-5: Placing macros next to each other with an offset
The following table shows a section of a Typical file.

<table>
<thead>
<tr>
<th></th>
<th>Typical worksheet identifier</th>
<th>Higher-level function</th>
<th>Mounting location</th>
<th>Page name</th>
<th>!</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>####[x=16]</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>BK3100</td>
<td>PLC</td>
<td>EAA</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>BK3200</td>
<td>PLC</td>
<td>EAA</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>BK3300</td>
<td>PLC</td>
<td>EAA</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>####</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- ####[X=16]: Control command to orient the macros to the X-coordinate. The X-coordinate contains the value "16". The control command is valid for the window macros BK3100.ema, BK3200.ema, BK3300.ema.
- Window macro BK3100.ema is placed on page =PLC+EAA/1 at the original insertion point.
- Window macro BK3200.ema is placed on page =PLC+EAA/1 in X direction next to the previous macro BK3100.ema. Its X position is determined from the coordinates of the previous macro plus its width. Its Y position is also adopted from the previous macro and is not changed.
- Window macro BK3300.ema is placed on page =PLC+EAA/1 in X direction next to the previous macro BK3200.ema. Its X position is determined from the coordinates of the previous macro plus its width. Its Y position is also adopted from the previous macro and is not changed.
- The #### control command ends the mode for orienting the macro to the X-coordinate.

8.1.4 Orientation to the [Y] Coordinate

If you orient your macro to the Y-coordinate when placing it, then the first macro is placed at its original insertion point and all further macros are placed below this in the Y-direction. You use the Y-coordinate to define the clearance in the Y-direction between the macros when they are placed below each other. You control the placement by entering the following control commands into the first <Typical worksheet identifier> column in the Typical file.

<table>
<thead>
<tr>
<th>Orientation to the [Y]-coordinate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
</tr>
<tr>
<td>Control command syntax</td>
</tr>
</tbody>
</table>

Note:

You should be aware of the fact that the number of macros that can be placed below each other on a schematic page is limited. When too many macros are placed next to each other then the macros are placed outside the plot frame.
8.1.4.1 Place Macros Below Each Other

The \#\#\#\#\#(y) control command allows you to place macros immediately below each other without any offset (distance between them).

![Diagram showing macros placed below each other](image)

Figure 8-6: Placing macros below each other, schematic view

| \#\#\#\#(y) | DOC | 01 | 1 |
| Window macro 1 | | | |
| Window macro 2 | | | |
| Window macro 3 | | | |

Figure 8-7: Place Macros Below Each Other
Example:

The following table shows a section of a Typical file.

<table>
<thead>
<tr>
<th></th>
<th>Typical worksheet identifier</th>
<th>Higher-level function</th>
<th>Mounting location</th>
<th>Page name</th>
<th>!</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>$$[y]$$</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>BK3100</td>
<td>PLC</td>
<td>EAA</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>BK3200</td>
<td>PLC</td>
<td>EAA</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>BK3300</td>
<td>PLC</td>
<td>EAA</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>$$$$</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- $$[y]$$: Control command to orient the macros to the Y-coordinate. The Y-coordinate contains no value. The control command is valid for the window macros: BK3100.ema, BK3200.ema, BK3300.ema.

- Window macro BK3100.ema is placed on page =PLC+EAA/1 at the original insertion point.

- Window macro BK3200.ema is placed on page =PLC+EAA/1 in Y-direction below the previous macro BK3100.ema. Its Y-position is determined from the coordinates of the previous macro plus its height. Its X-position is adopted from the placed macro.

- Window macro BK3300.ema is placed on page =PLC+EAA/1 in Y direction below the previous macro BK3200.ema. Its Y-position is determined from the coordinates of the previous macro plus its height. Its X-position is adopted from the placed macro.

- The $$ $$ control command ends the mode for orienting the macro to the Y-coordinate.

8.1.4.2 Placing Macros With Clearance Below Each Other

If you use the $$[y]$$ control command to allocate a value to the [Y]-coordinate, for example $$[y=8]$$, you can place macros below each other with an offset.

Figure 8-8: Placing macros with clearance below each other, schematic view
Macro Placement and Orientation

Figure 8-9: Placing macros with clearance below each other

Example:

The following table shows a section of a Typical file.

<table>
<thead>
<tr>
<th></th>
<th>Typical worksheet identifier</th>
<th>Higher-level function</th>
<th>Mounting location</th>
<th>Page name</th>
<th>!</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>###[y=8]</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>BK3100</td>
<td>PLC</td>
<td>EAA</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>BK3200</td>
<td>PLC</td>
<td>EAA</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>BK3300</td>
<td>PLC</td>
<td>EAA</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>###</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- ###[y=8]: Control command to orient the macros to the Y-coordinate. The Y-coordinate contains the value "8". The control command is valid for the window macros BK3100.ema, BK3200.ema, BK3300.ema.
- Window macro BK3100.ema is placed on page =PLC+EAA/1 at the original insertion point.
- Window macro BK3200.ema is placed on page =PLC+EAA/1 in Y-direction below the previous macro BK3100.ema. Its Y-position is determined from the coordinates of the previous macro plus its height. Its X position is also adopted from the previous macro and is not changed.
- Window macro BK3300.ema is placed on page =PLC+EAA/1 in Y direction below the previous macro BK3200.ema. Its Y-position is determined from the coordinates of the previous macro plus its height. Its X position is also adopted from the previous macro and is not changed.
- The ### control command ends the mode for orienting the macro to the Y-coordinate.

8.1.5 Orientation to the X- and Y-Coordinates

In order to exactly place each macro with its own X- and Y-coordinates, you can enter a coordinate pair for each macro in the Typical file. For this purpose, in the ! column (for deactivating / commenting), two extra columns with the headings X and Y have been inserted. Orienting the macros to the X and Y coordinates is useful when (e.g.) macros have different widths. In this case it is not sufficient to simply orient to the X- or Y-coordinates.

<table>
<thead>
<tr>
<th>Orientation to the X- and Y-coordinates</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
</tr>
<tr>
<td>Control command syntax</td>
</tr>
</tbody>
</table>
The Typical file has to be extended by the x and y columns.

### Table: Functional assignment

<table>
<thead>
<tr>
<th>TYPICAL</th>
<th>Functional assignment</th>
<th>Higher-level function</th>
<th>Installation site</th>
<th>Mounting location</th>
<th>Higher-level function number</th>
<th>User defined</th>
<th>Page</th>
<th>x</th>
<th>y</th>
<th>Variable 1</th>
<th>Variable 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>#(#x/y)</td>
<td></td>
<td>DOC</td>
<td>01</td>
<td></td>
<td></td>
<td></td>
<td>2</td>
<td>20</td>
<td>120</td>
<td>120</td>
<td>240</td>
</tr>
</tbody>
</table>

**Figure 8-10:** Placing macros at X and Y coordinate

**Figure 8-11:** Placing macros at X and Y coordinate, schematic view
The following table shows a section of a Typical file.

The **Functional assignment**, **Installation site**, **Higher-level function number**, **Document type** and **User-defined** identifier block columns have been hidden.

<table>
<thead>
<tr>
<th></th>
<th>Typical worksheet identifier</th>
<th>Higher-level function</th>
<th>Mounting location</th>
<th>Page name</th>
<th>!</th>
<th>x</th>
<th>y</th>
<th>Variable</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>####(x/y)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>BK3100</td>
<td>PLC</td>
<td>INPUTS</td>
<td>1</td>
<td></td>
<td>20</td>
<td>30</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>BK3200</td>
<td>PLC</td>
<td>INPUTS</td>
<td>1</td>
<td></td>
<td>120</td>
<td>130</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>####</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- In the first data row of the **Typical worksheet identifier** column, the ####(X/Y) control command represents the orientation to the X- and Y-coordinate.
- The BK3100.ema window macro has been allocated the coordinates 20 and 30 in the x- and y-columns.
- The BK3200.ema window macro has been allocated the coordinates 120 and 130 in the x- and y-columns.
- The #### control command concludes the mode for orientating the macros to the X- and Y-coordinate.

### 8.1.6 Reset the Macro Placement

If the macro placement is defined with the help of a control command, this placement type can be deactivated for the coming macros so that the placement for those macros is carried out in the same way as for the macro project.

<table>
<thead>
<tr>
<th>Place Macros on Existing Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Description</strong></td>
</tr>
<tr>
<td><strong>Control command syntax</strong></td>
</tr>
</tbody>
</table>
# Swapping Symbol Representation Types

If a window macro exists in different representation types, of which a certain type is to be applied, it is possible to specify the representation type for each macro in the TYPICAL file. For this purpose, the additional columns with the **Representation type** and **Variant** column headers are inserted before the ! column.

The representation type must be stated as a number - not as a name.

<table>
<thead>
<tr>
<th>Representation type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Place the specified representation type of a window macro.</td>
<td></td>
</tr>
<tr>
<td>1 = Multi-line</td>
<td></td>
</tr>
<tr>
<td>2 = Single-line</td>
<td></td>
</tr>
<tr>
<td>3 = Pair cross-reference</td>
<td></td>
</tr>
<tr>
<td>4 = Overview</td>
<td></td>
</tr>
<tr>
<td>5 = Part placement</td>
<td></td>
</tr>
<tr>
<td>6 = Multi-line Fluid</td>
<td></td>
</tr>
<tr>
<td>7 = PI diagram</td>
<td></td>
</tr>
</tbody>
</table>

Control command syntax: 1 - 7

The Typical file must to be extended by the **Representation type** and **Variant** columns.

![Figure 9-1: Specifying the macro representation type](image)
10 Swapping Macro Variant

If a window macro exists in different variants, of which a certain variant is to be applied, it is possible to specify the variant for each macro in the TYPICAL file. For this purpose, before the ! column (for deactivating / commenting), an additional column with the heading Variant is inserted.

The variant is specified with a letter from A to P:

<table>
<thead>
<tr>
<th>Variant</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
</tr>
<tr>
<td>Control command syntax</td>
</tr>
</tbody>
</table>

The Typical file has to be extended by the Variant column.

Figure 10-1: Specifying the macro variant
11 Syntax for Function Groups and Functions

You can administer the data in the Typical file in function groups. To do this, you create a table sheet for each function. The table sheet name corresponds to the function name. You identify associated table sheets by inserting the function group name in front of the function name: Function group@Function. Insert the separator, which is entered in the Separator for function groups field in the EEC One-Excel-Editor, between the function group name and function name.

Example:

Your Typical file contains 4 table sheets with the 4 table sheet names:

<table>
<thead>
<tr>
<th>Table sheets</th>
<th>Table sheet names</th>
</tr>
</thead>
<tbody>
<tr>
<td>1st Table sheet</td>
<td>Functiongroup_A@Function_1</td>
</tr>
<tr>
<td>2nd Table sheet</td>
<td>Functiongroup_A@Function_2</td>
</tr>
<tr>
<td>3rd Table sheet</td>
<td>Functiongroup_B@Function_3</td>
</tr>
<tr>
<td>4th Table sheet</td>
<td>Functiongroup_B@Function_4</td>
</tr>
</tbody>
</table>

The first two table sheets belong together because they have the same function group names. The last two table sheets belong together because they also have the same function group names.
12 Syntax for Calculation Variables

Calculation variables allow the calculation of multiple values during schematic generation. Calculation rules are defined in the calculation variables for this. You only need to change a value at one place in the calculation rules and all values to which the calculation variable apply are automatically updated when the schematic is generated.

In order for EPLAN to recognize such variables as calculation variables, these variables must be entered in the macro placeholder object with a defined syntax:

\[ \text{x|<Calculation variable name>_<Index>} \]

or

\[ \text{_x_<Calculation variable name>_<Index>} \]

Example:

\[
\begin{align*}
\text{x|TermX10_1} \\
\text{x|TermX10_2} \\
\text{x|TermX10_3} \\
\text{x|TermX10_4}
\end{align*}
\]

Figure 12-1: Placing macros at X and Y coordinate

All values for which the calculation rule is to apply receive the same calculation variable name. They are distinguished only by the index. The syntax of the calculation variables has the following components:

<table>
<thead>
<tr>
<th>Element</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>x</td>
<td>or <em>x</em></td>
</tr>
<tr>
<td>&lt;Calculation variable name&gt;</td>
<td>This is the name of the calculation variable.</td>
</tr>
<tr>
<td>_&lt;Index&gt;</td>
<td>The index allows distinguishing between multiple instances of the calculation variable in a macro placeholder object.</td>
</tr>
</tbody>
</table>

The EEC One loads the calculation variables in the Typical file and the Variables <Table sheet name> dialog. You define the calculation rules and assign these to the calculation variables there.
12.1 Calculation types

A calculation type for each calculation rule must be defined.

12.1.1 Increment

Allows you the calculation of a value, which begins with the start value and is increased by an offset value.

| Start value | The calculated value begins with this start value. |
| Offset      | The calculated value is changed by adding this offset value. |

12.1.2 Decrement

Allows you the calculation of a value, which begins with the start value and is decreased by an offset value.

| Start value | The calculated value begins with this start value. |
| Offset      | The calculated value is changed by subtracting this offset value. |

12.1.3 PLC Addressing 8 bit Digital

Allows calculation of an absolute PLC address for 8 bit PLC addressing with a digital signal type.

| Start byte  | Start value for the element of a PLC address that is usually used for the byte. |
| Start bit   | Start value for the element of a PLC address that is usually used for the bit. |
| Prefix      | Element of the PLC address. From left to right, the letters until the first separator or the first digit. All characters that are not letters or digits are interpreted as separators. |

12.1.4 PLC Addressing 16 bit Digital

Allows calculation of an absolute PLC address for 16 bit PLC addressing with a digital signal type.

| Start byte  | Start value for the element of a PLC address that is usually used for the byte. |
| Start bit   | Start value for the element of a PLC address that is usually used for the bit. |
| Prefix      | Element of the PLC address. From left to right, the letters until the first separator or the first digit. All characters that are not letters or digits are interpreted as separators. |

12.1.5 PLC Addressing Analog

Allows calculation of an absolute PLC address for PLC addressing with an analog signal type. 2 bytes per analog signal are used for addressing.

| Start byte  | Start value for the element of a PLC address that is usually used for the byte. |
| Prefix      | Element of the PLC address. From left to right, the letters until the first separator or the first digit. All characters that are not letters or digits are interpreted as separators. |

12.1.6 Number Blockwise
Allows you the numbering in blocks in combination with the **Start value** and **Number of functions** fields. You specify the start value for numbering in the **Start value** field. In the **Number of functions** field you can specify how many functions are contained in one block and are allocated the same value.

<table>
<thead>
<tr>
<th><strong>Start value</strong></th>
<th>The calculated value begins with this start value.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Quantity</strong></td>
<td>The number of functions specifies how many functions are contained in one block and are allocated the same value.</td>
</tr>
</tbody>
</table>
13 Rules for Formatting / Data Entry in the Typical File

The Excel cells of the *.xlsx Typical file can be formatted with the following number formats:

- Standard
- Number
- Text

The EEC One contains rules, which facilitate the data entry and provide a clearer overview of the Typical file.

The following rule applies to values, which you enter in the columns for identifier block, page name, X- and Y-coordinates, variables and calculation variables.

<table>
<thead>
<tr>
<th>Rule</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>No entry</td>
<td>If an Excel cell of a data row does not contain any entry, the macro is given the value of a row above it. Values entered into the Excel table are valid until a new value is found. This means that the same value need not be entered multiple times for the same macro.</td>
</tr>
</tbody>
</table>

Only variables columns

<table>
<thead>
<tr>
<th>Rule</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;_&quot;</td>
<td>If an Excel cell of a data row contains an underscore &quot;_&quot;, the macro is not given the value of a row above it. This allows you to prevent a variable being assigned a value.</td>
</tr>
<tr>
<td>&quot;;__;&quot;</td>
<td>If you want to enter several values in an Excel cell of a data row, for example for connection descriptions, you must enter the values separated by a semicolon.</td>
</tr>
</tbody>
</table>
## 14 Meaning of Colors of the Typical File

When the macros are entered in the Typical file, the Excel cells are automatically colored. The colors facilitate the orientation in the Typical file. Excel cells with macros that have been commented out are not colored.

### Column Typical worksheet identifier

<table>
<thead>
<tr>
<th>Color</th>
<th>Cause</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red</td>
<td>Macro not present</td>
<td>The EEC One cannot find the macro. Possible causes:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1. The relative or absolute file path is not correct.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. The macro is not in the macro folder, which you have stated in the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>EEC One-Excel-Editor.</td>
</tr>
<tr>
<td>Dark blue</td>
<td>Page macro</td>
<td>The table cell contains the relative or absolute file path of a page</td>
</tr>
<tr>
<td></td>
<td></td>
<td>macro. The EEC One recognizes the entry as *.emp page macro.</td>
</tr>
<tr>
<td>Light blue</td>
<td>Window macro</td>
<td>The table cell contains a relative or an absolute file path to a window</td>
</tr>
<tr>
<td></td>
<td></td>
<td>macro. The EEC One recognizes the entry as *.ema window macro.</td>
</tr>
</tbody>
</table>

### Variables columns

<table>
<thead>
<tr>
<th>Color</th>
<th>Cause</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>Macro contains variables</td>
<td>The macro contains the variable.</td>
</tr>
<tr>
<td>Light green</td>
<td>The macro contains calculation variables</td>
<td>The variable is a calculation variable. The macro contains the calculation variable.</td>
</tr>
<tr>
<td>Yellow</td>
<td>Excel formula</td>
<td>The Excel cell contains an Excel formula.</td>
</tr>
<tr>
<td>Light yellow</td>
<td>Excel validation rule</td>
<td>The Excel cell contains an Excel validation rule.</td>
</tr>
</tbody>
</table>
# 15 Command Line Parameters

The EEC One-Module EECOne.exe loads the typical.txt transfer file.

In order to start the schematic generation, the EECOne.exe file in the installation folder must be opened.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Optional?</th>
<th>Example</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>/P:&quot;Directory path&quot;</td>
<td>No</td>
<td>/P:&quot;C:\Users\Public\EPLAN\Electric P8&lt;Version number&gt;\Projects&lt;Company code&gt;&lt;Project name.elk&gt;&quot;</td>
<td>Project folder path and project folder name. The EEC One-Module now knows the project folder of the target project for the schematic generation and the storage location of the transfer file.</td>
</tr>
<tr>
<td>/M:&quot;DirectoryPath&quot;</td>
<td>No</td>
<td>/M:&quot;C:\Users\Public\EPLAN\Electric P8&lt;Version number&gt;\Projects&lt;Company code&gt;\Macros&quot;</td>
<td>Path to the macro folder. All macros, which are specified relatively in the transfer file, are searched in this folder and loaded.</td>
</tr>
<tr>
<td>/DT:&quot;FilePath&quot;</td>
<td>No</td>
<td>/DT:&quot;C:\Users\Public\EPLAN\Electric P8&lt;Version number&gt;\Projects&lt;Company code&gt;\typical.txt&quot;</td>
<td>Path and file name of the transfer file.</td>
</tr>
<tr>
<td>/Log:&quot;FilePath&quot;</td>
<td>No</td>
<td>/Log:&quot;C:\Users\Public\EPLAN\Electric P8&lt;Version number&gt;\Projects&lt;Company code&gt;\Typical.log&quot;</td>
<td>Path and file name of the log file.</td>
</tr>
<tr>
<td>/Language:&quot;Lang&quot;</td>
<td>No</td>
<td>/Language:&quot;en-US&quot;</td>
<td>Language ID</td>
</tr>
<tr>
<td>/LogLevel:&quot;Level&quot;</td>
<td>No</td>
<td>/LogLevel:&quot;warning&quot;</td>
<td>Defines the type of messages that are output. The following are available: debug, error, warning, none</td>
</tr>
<tr>
<td>/K:&quot;Typical worksheet identifier&quot;</td>
<td>Yes</td>
<td>/K:TYPICAL</td>
<td>Defines the Typical worksheet identifier.</td>
</tr>
</tbody>
</table>
16 Installing EEC One

The EPLAN Engineering Center One is installed via the installation assistant.

1. Double-click the Setup.exe file.
2. If a dialog with a security warning is displayed, then confirm the dialog.
   - The EEC One is installed.
   - Then you can select the option Starting EEC One.
17 Starting EEC One

The EECOne_Excel_Editor.xlsm file is the start file of the EEC One-Excel-Editor. After a standard installation this file will be in the folder C:\Programs (x86)\EPLAN\EECOne\<Version number>.

Preconditions:

- You have installed Microsoft Excel.
- Navigate to the C:\Programs (x86)\EPLAN\EECOne\<Version number> folder.
- Open the EECOne_Excel_Editor.xlsm file.
- Save the file e.g. in the *.edb EPLAN project folder.

Or

- Navigate to the C:\Programs (x86)\EPLAN\EECOne\<Version number>\Templates templates folder.
- Open the EECOne_Excel_Editor.xlsm template file.
- Save the file e.g. in the *.edb EPLAN project folder.

If you have started the EEC One-Excel-Editor for the first time, you need to Adjust the Security Level for Excel Macros.
18 Adjusting the Security Level for Excel Macros

In order to work with the EEC One it is necessary to adjust the security level for Excel macros in the Excel application, which allows you to execute legitimate Excel macros.

Precondition:
You have installed and opened Microsoft Excel.

Tools > Macro > Security
1. In the Security dialog, select the Security level tab.
2. Select (e.g.) the Medium option and click [OK].

The next time you start EEC One-Excel-Editor, a security warning is displayed allowing you to activate macros.
You can now begin configuring the EEC One-Excel-Editor.
19 Show EEC One Ribbon

The EEC One ribbon is displayed in the EEC One-Excel-Editor by default. If this ribbon is not visible, then it must be made visible.

Precondition:
You have started the EEC One-Excel-Editor.

1. In the EEC One-Excel-Editor select File > Options.
2. Under Options select Adjust ribbon.
3. In the Main tabs list highlight the Add-Ins tab.

The EEC One ribbon is visible.
20 Configure the EEC One-Excel-Editor

You use the EEC One-Excel-Editor to configure the Typical file and control the EEC One-Module. Specify the folder and file paths for all folders and files that are needed by the EEC One for automatically generating schematics. You can also specify project structure information.

Precondition:
You have started the EEC One-Excel-Editor.

20.1 Define EEC One Settings

Use the EEC One settings for configuring the EEC One-Excel-Editor and EEC One-Module.

1. To configure the dialog language of the EEC One-Excel-Editor, select an entry in the Language drop-down list.
   - The program version, file name and program folder of the EEC One-Excel-Editor are automatically displayed in the fields below.
2. To define the type of messages to be displayed in the log file when generating schematic pages, select an entry in the Logging level drop-down list.
3. To display the messages after generating schematics, select Yes in the Show log drop-down list.

20.2 Define the EPLAN Electric P8 / EPLAN Fluid Version

You use the EPLAN Electric P8 / EPLAN Fluid settings to establish the connection between EEC One and EPLAN Electric P8 / EPLAN Fluid. This also provides EEC One with access to the EPLAN macro folder.

1. Select an EPLAN Electric P8 or EPLAN Fluid version from the Program folder drop-down list.
   - The version number is entered in the Version field.
   - The EPLAN macro folder is entered into the Macro folder field.
2. In order to specify another macro folder, click next to the Macro folder on [...] field. In the following dialog, select the folder with the required EPLAN macros and click on [OK].
3. To re-enter the EPLAN macro folder, click the Enter EPLAN macro folder hyperlink next to the Macro folder field.

20.3 Define the Typical

You use the Typical settings to define the template for a Typical file that is copied into the *.edb project folder of the selected target project, assuming that this folder does not yet contain a *.xls Typical file. You also define which Excel rows and columns contain headers and data.

1. Select the template, e.g. typical.xlsx and click [Open].
2. In the Typical worksheet identifier field, enter the text entered into the first column of the first header row in the Typical file, e.g. TYPICAL.
   - This defines the Excel row in the Typical file as a header row and this will not be reported when generating schematics. This is also the identifier that must exist in the Typical file for an *.xlsx file to be recognized as a valid Typical file.
3. If you wish to manage your data in function groups, then in the Separator for function groups field, enter a character to be used in the Syntax for Function Groups and Functions, which separates the function group names from the function names.

4. Enter the row number of the Excel row containing the first data row of the Typical file into the Start row field.

5. Enter the letter or number of the Excel column in the Typical file containing the first data column into the Start column field.

20.4 Defining the Project Structure
You use the Project Structure Settings to define which identifier block columns in the Typical file are to be displayed and which are not displayed. You also defined whether the page name column is displayed or not.

1. Select the Available entry for all identifier blocks whose columns in the Typical file are to be displayed.

2. To display the page name column in the Typical file, in the Page name field, select the Available entry.

20.5 Define the Target Project
You use the Target project settings to define the EPLAN project where the automatically generated schematics are to be output.

1. In the Target project area, click [...] next to the File path field, select your *.elk target project in the subsequent dialog and then click [Open].
   - The project name is entered into the Project name field.

2. Select the menu item File > Save.

You can now Edit the Typical file.
21 Edit the Typical file

In the Typical file, e.g. typical.xlsx, you define all the project data and macro placement information needed for generating schematics.

Precondition:
You have configured and started the EEC One-Excel-Editor.

21.1 Open Typical File

Ideally, you open the *.xlsx Typical file using the EEC One-Excel-Editor.

1. Start the EEC One-Excel-Editor.
   - The specified *.xlsx Typical file is opened.

A new Typical file based on the typical.xltx template is created by double-clicking the template file. After a standard installation, this is located in the C:\Programs (x86)\EPLAN\EECOne\<Version number>\Templates folder.

21.2 Define the Typical Name

A table sheet is named Typical because it is used to manage standardized functions for machines and plants. Enter a name for the Typical or the function into the table sheet name.

1. Select the table sheet name of the worksheet and then select Popup menu > Rename.
2. Enter a descriptive name and press the [Enter] key.
3. If you also manage your functions in the Typical file using function groups, then enter the Syntax for Function Groups and Functions into the table sheet name.
4. Select the menu item File > Save.

21.3 Entering a Typical Worksheet Identifier

The Typical worksheet identifier identifies the *.xlsx file as a valid Typical file. The Typical worksheet identifier also identifies a table row as a header row. All values in the row containing the Typical worksheet identifier are headings. These values are not reported.

1. In the first column of the first row, enter the Typical worksheet identifier that you entered in the Typical worksheet identifier field of the EEC One-Excel-Editor.
2. Select the menu item File > Save.

21.4 Use Drag & Drop to Enter a Macro Name Into the Typical File

If you have stated a macro folder in the EEC One-Excel-Editor, you can enter macro names via Drag & Drop from the macro overview in the Typical file.

1. In the Typical file, select a field in the first column of a data row.
2. In the EEC One Ribbon click 🔄.
3. In the Macros tab, select a macro and drag it into the selected field via Drag & Drop.
   - If the macro is in the macro folder, which you have specified in the EEC One-Excel-Editor, only the relative path and macro name without file name extension are entered in the field.
If the macro is not in the specified macro folder, the entire absolute path and macro name are entered with file name extension.

4. Select the menu item **File > Save**.

### 21.5 Display the Entered Macro in the Macro Preview

If you have entered a macro name in the Typical file via Drag & Drop, you can view the associated macro directly from the Typical file in a macro preview.

1. Select a macro name in the *Typical worksheet identifier* column of the Typical file.

2. In the **ECC One Ribbon** click .
   - The macro is displayed in an EPLAN preview dialog.

### 21.6 Automatically Enter Placeholder Object Variables

A macro with a macro placeholder object can contain variables. The variables are replaced with values on schematic generation. If you **Deactivate a macro**, then these variables are not read.

**Preconditions:**

- Your macro contains a placeholder object. Variables are defined in the placeholder object.
- You have used Drag & Drop to enter the macro name into the Typical file.

2. In the EEC One ribbon click , and in the subsequent dialog click **[Reload]**.
   - All variables in the placeholder object are transferred into the header row of the Typical file and also into the dialog. If a variable already exists in a header row, then this column is used.
   - You can recognize which variables are contained in which macros by the coloring of the corresponding table cells in the variable columns.
   - If the EEC One cannot find a macro, then the corresponding table cell in the *Typical worksheet identifier* column is colored red.
   - If the EEC One recognizes the table cell entry as an *.emp page macro, then the corresponding cell in the *Typical worksheet identifier* column is colored blue.

3. Select the menu item **File > Save**.

### 21.7 Changing the Sequence of the Variable Columns

If you wish to change the sequence of the variable columns, you do not need to do this manually.

1. Activate the Typical file and in the **ECC One ribbon** click .
   - The sequence of the variables in the *Variables <table sheet name>* dialog in the **Variable** column from top to bottom corresponds to the sequence of the variables from left to right in the Typical file.

2. In the *Variables <table sheet name>* dialog in the **Variable** column, highlight a variable and click on , or .
   - The variable columns are directly moved in the Typical file.

3. Click **[Close]**.

4. Select the menu item **File > Save**.
21.8 Deactivate a Macro

You can deactivate a macro that you have entered into the Typical file. The macro is then ignored when reading variables and generating schematics.

1. In the ! column (column for deactivating / commenting) enter an exclamation mark ! into the row of the corresponding macro.

2. Select the menu item File > Save.
22 Defining Structure Identifiers and Page Names in the Typical File

You use the page names and structure identifiers to define the project page where a macro is to be placed and the page structure level where this project page is to be sorted. If you specify structure identifiers and / or page names in the Typical file that are not yet present in the target project, then new structure identifiers and / or project pages are created in the target project on schematic generation. Manual changes on existing pages are overwritten.

Preconditions:

- You have used Drag & Drop to enter a macro name into the Typical file.
- In the Project structure settings in the EEC One-Excel-Editor, you have defined which identifier block columns are to be displayed in the Typical file.

1. In a data row containing a macro name, enter a structure identifier for the page structure into the identifier block column, e.g. in the Higher-level function column, enter the PLC structure identifier.
   - If you do not enter a structure identifier into the identifier block column, then the structure identifier from the cell above is used.

2. Enter the page name of the project page where the macro is to be placed into the Page name column.
   - If you do not enter a page name, then the page name from the cell above is used.

3. Select the menu item File > Save.
23 Defining Macro Placement in the Typical File

In the Typical file, e.g. typical.xlsx, you use control commands and coordinate entries to define how the macros are to be placed in the target project.

23.1 Place Macros Next to Each Other

With this method, multiple macros are placed column-wise next to each other on the schematic page. You use the Orientation to the Y-coordinate control command for this.

Preconditions:

1. You have configured the EEC One-Excel-Editor.
2. You have configured the Typical file.
3. Start the configured EEC One-Excel-Editor.
   a. One Typical file is automatically opened.
5. To place macros next to each other without additional clearance, enter the ####[X] control command into the <Typical worksheet identifier> column of a data row.
6. To place macros next to each other with additional clearance, e.g., 8, enter the ####[X=8] control command into the <Typical worksheet identifier> column of a data row.
7. Enter the macro names into the subsequent data rows, e.g., by using Drag & Drop to enter a macro name into the Typical file.
   a. This results in (e.g.) the following entries:
      ####[X=8]
      Macro1
      Macro2
      Macro3
8. Select the menu item File > Save.

23.2 Place Macros Below Each Other

With this method, multiple macros are placed row-wise below each other. You use the Orientation to the Y-coordinate control command for this.

Preconditions:

1. You have configured the EEC One-Excel-Editor.
2. You have configured the Typical file.
3. Start the configured EEC One-Excel-Editor.
   a. One Typical file is automatically opened.
5. To place macros below each other without additional clearance, enter the ####[Y] control command into the <Typical worksheet identifier> column of a data row.
6. To place macros below each other with additional clearance, e.g., 8, enter the ####[Y=8] control command into the <Typical worksheet identifier> column of a data row.
5. Enter the macro names into the subsequent data rows, e.g., by using Drag & Drop to enter a macro name into the Typical file.
   - This results in (e.g.) the following entries:
     ####[Y=8]
     Macro1
     Macro2
     Macro3

6. Select the menu item **File > Save**.

### 23.3 Place Each Macro at its Own X- and Y-Coordinates

With this method, multiple macros are placed independently at specified X and Y coordinates. You use the Orientation to the X- and Y-coordinate control command for this.

**Preconditions:**

- You have configured the EEC One-Excel-Editor.
- You have configured the Typical file.

1. Start the configured EEC One-Excel-Editor.
   - One Typical file is automatically opened.
3. Insert two further columns in the Typical file after the ! column (for deactivating / commenting).
4. Assign the headings X and Y to the columns.
5. In the `<Typical worksheet identifier>` column of a data row, enter the #### [X/Y] control command.
6. Enter a macro name into the subsequent data row, e.g. by using Drag & Drop to enter a macro name into the Typical file.
7. Enter the values of the X and Y coordinates into the X and Y columns of the same row.
8. Select the menu item **File > Save**.
9. Activate the EEC One-Excel-Editor.
10. In the **Start column** field of the EEC One-Excel-Editor, enter the column letter or number of the X column.
11. Select the menu item **File > Save**.
24 Generating Schematic Pages with EEC One

A Typical file, e.g. typical.xlsx, consists of one or more table sheets. One table sheet corresponds to one Typical. If you manage your Typical file using function groups and functions, and you conform to the syntax for function groups and functions, then the table sheets are displayed sorted by function group.

24.1 Generate a Schematic from a Typical
You can generate schematic pages exclusively from the active table sheet of the Typical file.

Preconditions:
- You have configured the EEC One-Excel-Editor and the Typical file.
- You have defined the macro placement in the Typical file.
1. Start the configured EEC One-Excel-Editor.
   - One Typical file is automatically opened.
2. Activate the desired table sheet.
3. In the EEC One Ribbon click .
   - The EEC One-Module is started. The data is written to a *.txt transfer file, e.g. typical.txt. The schematic pages are generated in the target project.

24.2 Generate Schematics from Several Table Sheets
You can also select multiple table sheets of a Typical file for schematic generation.

Preconditions:
- You have configured the EEC One-Excel-Editor and the Typical file.
- You have defined the macro placement in the Typical file.
1. Start the configured EEC One-Excel-Editor.
   - One Typical file is automatically opened.
3. In the EEC One Ribbon click .
   - In the Generate dialog, the Available Typical field shows all table sheets in the selected Typical file. If you have used the syntax for function groups and functions in your table sheet names, then the table sheets are displayed sorted by function group.
4. Select a function group or a single table sheet, one after another, and click .
   - The table sheets will be moved into the Selected Typical field.
5. To change the sequence of schematic generation, select a table sheet and click or .
6. Click [Generate] to start the schematic generation.
   - The EEC One-Module is started. The data is written to a *.txt transfer file, e.g. typical.txt. The schematic pages are generated in the target project.
25 EEC One Ribbon

Preconditions:

- You have started the EEC One-Excel-Editor and opened the EEC One ribbon.

Ribbon:

<table>
<thead>
<tr>
<th>Button</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Button Image]</td>
<td>Directly generates the schematic page from the active table sheet of the Typical file, e.g. typical.xlsx. The EEC One-Module is started. The configuration and macro data of the current table sheet of the Typical file are output to a transfer file, e.g., typical.txt. The schematic pages are generated in the target project.</td>
</tr>
<tr>
<td>![Button Image]</td>
<td>Opens the dialog for selecting typicals and for generating schematic pages. Shows all table sheet names in the Typical file, e.g. typical.xlsx. Allows the selection of one or more table sheet names for schematic generation and definition of the sequence. The EEC One-Module is started. The configuration and macro data of all selected table sheets of the Typical file are output to a transfer file, e.g., typical.txt. The schematic pages are generated in the target project.</td>
</tr>
<tr>
<td>![Button Image]</td>
<td>Opens the Preview / Macro selection &lt;project name&gt; dialog. To do this, the program folder of EPLAN Electric P8 / EPLAN and the macro folder must be entered into the EEC One-Excel-Editor. Allows displaying a preview of all project pages. You can also display a preview of all macros in connected drives and folders. Drag &amp; Drop can be used to enter the macros into the Typical file, e.g. typical.xlsx.</td>
</tr>
<tr>
<td>![Button Image]</td>
<td>Opens the Variables &lt;Table sheet name&gt; dialog. Allows reading of all variable headings that you have defined, starting at column 11 of the headings row, in the Typical file, e.g. typical.xlsx.</td>
</tr>
<tr>
<td>![Button Image]</td>
<td>Loads the project properties from the EPLAN target project into the Typical file. Allows you to check and edit the project properties of the EPLAN target project in EEC One.</td>
</tr>
<tr>
<td>![Button Image]</td>
<td>Writes the project properties, which you have loaded from the EPLAN target project into the Typical file and changed therein, back to the EPLAN target project.</td>
</tr>
</tbody>
</table>

25.1 Dialog Preview / Macro Selection - <Project name>

Dialog call:

- You have started the EEC One-Excel-Editor.
- You have selected a suitable EPLAN version in the Program folder field, and EPLAN has automatically entered the EPLAN macro folder in the Macro folder field.
- In the Target project area, in the File path field you have selected a suitable target project.

1. In the EEC One Ribbon click ![Button Image].

In this dialog, you can display a preview of all project pages of the target project. You can also display a preview of all macros in connected drives and folders.
The following dialog element is available:

**Macros:**

This tab shows the folder structure of your workstation and the mapped drives. When opening the dialog, the folder that you have selected as the macro folder in the EEC One-Excel-Editor is automatically loaded. Window macros (*.ema) and page macros (*.emp) are displayed. When you select a macro, a graphical preview of the macro is shown in the area at the upper right. The path of the macro file is shown at the lower right. All variables contained in the macro are also displayed.

### 25.2 Dialog Generate / Typical

**Preconditions:**
- You have started the EEC One-Excel-Editor.
- You have opened a Typical file, e.g. *typical.xlsx*.

1. In the EEC One Ribbon click .

This dialog shows all table sheet names in the Typical file, e.g. *typical.xlsx*. This allows selection of the table sheet names for the schematic generation and the schematic generation to be started. A table sheet is named Typical because it is used to manage standardized functions for machines and plants.

**Dialog Call Typical**

- You have started the EEC One-Excel-Editor.
- You have opened a Typical file, e.g. *typical.xlsx*.

1. In the EEC One Ribbon click .

This dialog shows all table sheet names of the table sheets in the Typical file, e.g. *typical.xlsx*. A table sheet is named Typical because it is used to manage standardized functions for machines and plants.

The following dialog elements are available:

#### Available typicals:

Shows all table sheets in the Typical file, e.g. *typical.xlsx*, where the first column of the header row contains the same **Typical worksheet identifier** as the EEC One-Excel-Editor. If you also manage your functions in the Typical file using function groups and you have conformed to the syntax for function groups and functions in the table sheet names, then the table sheets are displayed sorted by function group.

#### Selected typical:

Shows all table sheets that you have selected in the Available Typical field and selected via .

**Toolbar:**

<table>
<thead>
<tr>
<th>Button</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Button" /></td>
<td>Moves the selected entry from the Available Typical field into the Selected Typical field.</td>
</tr>
<tr>
<td><img src="image" alt="Button" /></td>
<td>Deletes the selected entry from the Selected Typical field.</td>
</tr>
<tr>
<td><img src="image" alt="Button" /></td>
<td>Moves the selected entry in the Selected Typical field upwards by one position.</td>
</tr>
<tr>
<td><img src="image" alt="Button" /></td>
<td>Moves the selected entry in the Selected Typical field downwards by one position.</td>
</tr>
</tbody>
</table>

**Generate:**

Generates one or several schematic pages in the target project on the basis of the table sheets, which are entered in the Selected Typical field. Generates a transfer file, e.g. *typical.txt* in the *.edb* EPLAN project folder. The macro data of all selected table sheets is output to this transfer file.
25.3 Dialog Variables <Table Page name>

Preconditions:

- You have started the EEC One-Excel-Editor.
- You have opened a Typical file, e.g. typical.xlsx.

1. In the EEC One Ribbon click 

You use this dialog to manage the variables and calculation types of the calculation variables that you have read from the Typical file, e.g. typical.xlsx.

The following dialog elements are available:

**Variable:**
Shows all variables and calculation variables that you have read from the Typical file, e.g. typical.xlsx via [Reload]. You can define the sequence of the variables using the toolbar buttons. This setting directly affects the sequence of the variable columns and calculation variable columns in the Typical file.

**Rule:**
Shows the rule name of the calculation rule that you have defined for the corresponding calculation variable in the Rule <Rule name> dialog.

**Calculation type:**
Shows the rule name of the calculation rule that you have defined for the corresponding calculation variable in the Rule <Rule name> dialog.

**Show rules only:**
If this check box is selected, then only the calculation variables are displayed. All other variables are hidden.

[Reload]:
Automatically enters all variables and calculation variables in the active Typical file into the dialog.

**Toolbar:**

<table>
<thead>
<tr>
<th>Button</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>![ ]</td>
<td>This button is available when you have entered a calculation variable with valid syntax into the Variable / Rule / Calculation type columns and a calculation variable is selected. Opens the Rule &lt;Rule name&gt; dialog. Allows definition of the calculation rule.</td>
</tr>
<tr>
<td>![ ]</td>
<td>Moves the selected entry to the start of the list.</td>
</tr>
<tr>
<td>![ ]</td>
<td>Moves the selected entry upwards by one position.</td>
</tr>
<tr>
<td>![ ]</td>
<td>Moves the selected entry downwards by one position.</td>
</tr>
<tr>
<td>![ ]</td>
<td>Moves the selected entry to the end of the list.</td>
</tr>
</tbody>
</table>

25.4 Dialog Rule <Rule name>

Preconditions:

- You have started and configured the EEC One-Excel-Editor.
- You have opened a Typical file, e.g. typical.xlsx.

1. In the EEC One Ribbon click 

In this dialog you define the calculation rules. Calculation rules are assigned to calculation variables.
The following dialog elements are available:

**Type:**

Select the calculation type of the calculation rule in the calculation variable. The calculation type is shown in the `Variables <Table sheet name>` dialog in the `Calculation type` column.

- **Increment**: Together with the **Start value** and **Offset** fields, allows calculation of a value that begins with the start value and is added with an offset value. Allows the automated numbering of entries in the typical.xlsx in ascending order.
- **Decrement**: Together with the **Start value** and **Offset** fields, allows calculation of a value that begins with the start value and is subtracted by an offset value. Allows the automated numbering of entries in the typical.xlsx in descending order.
- **PLC addressing 8 bit digital**: Together with the **Start byte**, **Start bit** and **Prefix** fields, allows calculation of a PLC address for 8 bit PLC addressing with a digital signal type.
- **PLC addressing 16 bit digital**: Together with the **Start byte**, **Start bit** and **Prefix** fields, allows calculation of a PLC address for 16 bit PLC addressing with a digital signal type.
- **PLC addressing analog**: Together with the **Start byte**, and **Prefix** fields, allows calculation of an absolute PLC address for PLC addressing with an analog signal type. 2 bytes per signal are used for addressing.
- **Number blockwise**: Together with the **Start value** and **Number of functions** fields, allows to number blockwise. You specify the start value for numbering in the **Start value** field. In the **Number of functions** field you can specify how many functions are contained in one block and are allocated the same value.

**Start value:**

This field is available if you have selected **Increment**, **Decrement**, or **Number blockwise** in the **Type** field. Specify the start value of the calculation here.

**Distance:**

This field is available if you have selected **Increment** or **Decrement** in the **Type** field. Enter the value to be added or subtracted here. If you use the calculation rule for (e.g.) device tag numbering, then you can use the offset value to define the increment.

**Start byte:**

This field is available if you have selected **PLC addressing 8 Bit digital**, **PLC addressing 16 Bit digital**, or **PLC addressing analog** in the **Type** field. Here you enter the start value for the element of a PLC address that is usually used for the byte.

**Start bit:**

This field is available if you have selected **PLC addressing 8 Bit digital** or **PLC addressing 16 Bit digital** in the **Type** field. Here you enter the start value for the element of a PLC address that is usually used for the bit.

**Prefix:**

This field is available if you have selected **PLC addressing 8 Bit digital**, **PLC addressing 16 Bit digital**, or **PLC addressing analog** in the **Type** field. Here you enter the character normally used as the prefix in the PLC address. From left to right, this is all the letters until the first separator or the first digit. All characters that are not letters or digits are interpreted as separators. In a PLC address `A001.0,E001.0` these are (e.g.) the letters `A` and `E`.

**Apply to all worksheets:**

If this check box is selected then the calculation rules are used in all table sheets of the currently active workbook.
26 Index

C
Calculation type .......................................39
Calculation variables.................................38
Colors...................................................42
Command line opening................................43
Command line parameters...........................43
Control command
    ### ..............................................27, 29, 31, 32, 34
    ###[X/Y] ...........................................32
    ###[X] .............................................26
    ###[y] .............................................29

D
Data input .............................................41
Data rows .............................................15

E
EEC One-Excel-Editor
    configuring........................................48
EPLAN Electric P8 ......................................6
EPLAN Fluid ............................................6
Excel macros
    Security level......................................46

F
Files ....................................................10
Folders ................................................10
Function groups ......................................37
Function ranges ......................................7

H
Hardware requirements
    Network .............................................8
    Workstation ......................................8

I
Installation ..........................................44
Installation assistant ............................44

M
Macro project ....................................... 7, 20
Macros ..................................................20
    [Y]-coordinate ....................................29
    Orientation .......................................25
    Representation types .............................35
    Variants ..........................................36
    X-coordinate .....................................26

N
Number formats .....................................41

O
Overview of Functions .............................. 7

P
Page macros ...........................................21
Page names ..........................................23
Page properties .....................................24
Placeholder objects ............................... 7

R
Ribbon ..................................................47, 57

S
Software requirements
    Microsoft products ................................9
    Operating systems ................................8
Starting ..................................................45
Structure identifiers ...............................23

T
Table sheet ...........................................14
Typical ..................................................7
Typical file ..........................................14
    Defining macro placement ......................54
    Defining page names ............................53
    Defining structure identifiers ................53
    Edit .................................................50
<table>
<thead>
<tr>
<th>V</th>
<th>W</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variables</td>
<td>Window macros</td>
</tr>
<tr>
<td>..........................7, 15</td>
<td>..................................................22</td>
</tr>
<tr>
<td>Variant projects</td>
<td></td>
</tr>
<tr>
<td>..........................7</td>
<td></td>
</tr>
</tbody>
</table>